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Disclaimers(P. 5)
Copyright(P. 6)
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How to Use the Manual
This explains things that you need to know in order to use this manual.
Notations Used in the Manual(P. 4)
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Notations Used in the Manual
This explains symbols and settings used in this manual.

Symbols Used in This Manual
In this manual, explanations of items and operations that must be followed while using the driver are set forth
the symbols that indicate the following.
IMPORTANT
● Indicates operational requirements and restrictions. Be sure to read these items carefully to operate the
product correctly, and avoid damage to the product.
NOTE
● Indicates a clarification of an operation, or contains additional explanations for a procedure. Reading these
notes is highly recommended.

About Settings
In this manual, setting names displayed on the computer screen are represented as shown in the following
examples.
Example:
[Print]
[OK]
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Disclaimers
The information in this document is subject to change without notice.
CANON INC. MAKES NO WARRANTY OF ANY KIND WITH REGARD TO THIS MATERIAL, EITHER EXPRESS OR
IMPLIED, EXCEPT AS PROVIDED HEREIN, INCLUDING WITHOUT LIMITATION, THEREOF, WARRANTIES AS TO
MARKETABILITY, MERCHANTABILITY, FITNESS FOR A PARTICULAR PURPOSE OF USE OR NON-INFRINGEMENT.
CANON INC. SHALL NOT BE LIABLE FOR ANY DIRECT, INCIDENTAL, OR CONSEQUENTIAL DAMAGES OF ANY
NATURE, OR LOSSES OR EXPENSES RESULTING FROM THE USE OF THIS MATERIAL.
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Copyright
Copyright CANON INC. 2017
No part of this publication may be reproduced, transmitted, transcribed, stored in a retrieval system, or
translated into any language or computer language in any form or by any means, electronic, mechanical,
magnetic, optical, chemical, manual, or otherwise, without the prior written permission of Canon Inc.
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Trademarks
Microsoft and Windows are either registered trademarks or trademarks of Microsoft Corporation in the United
States and/or other countries.
Apple, Mac, macOS, OS X, and Macintosh are trademarks of Apple Inc.
Other product and company names herein may be the trademarks of their respective owners.

7

Before Use

Before Use
Before Use .............................................................................................................................................................. 9
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Before Use
● The newest driver versions are released on the Canon website. You can download them as necessary after
checking your operating environment.
Canon website: http://www.canon.com/
● The functions that you can use may vary according to the following conditions.
- The device you are using and its configuration
- The device firmware version
- The option configuration
- The driver version
- The environment of the computer you are using
● There may be instances where the illustrations of displays and content of procedures in this manual differ
from what is actually displayed.
● The descriptions in this manual use examples from macOS 10.12 (Sierra).
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Installing the Driver
This section explains driver installation and device preparation.
Flow of Preparations for Faxing(P. 12)
Pre-installation Check(P. 13)
Installing the Driver(P. 16)
Registering a Fax(P. 17)
Setting the Options of the Device(P. 29)
Uninstalling a Driver(P. 35)
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Flow of Preparations for Faxing
This driver is a macOS fax driver for Canon devices.
It can be used to directly send faxes from a computer without printing the images and documents, etc. created
in applications.
Before using the driver and printing, there are preparations that need to be done beforehand.
Carry out preparations and settings in the following order.
1. Obtain an installer by one of the following methods.
- Download it from the Canon website (http://www.canon.com/)
- Supplied CD-ROM
2. Install the driver to the operating system.
3. Register the fax you want to use to the operating system.
4. Set the device options as necessary.
NOTE
● You can check the version of the installed driver in the [General Settings] panel.

Related Topics
Installing the Driver(P. 16)
Registering a Fax Connected by TCP/IP(P. 18)
Registering a Fax Connected by USB(P. 22)
Registering a Fax Connected by Bonjour(P. 26)
Enabling Automatic Setting of the Options of the Device(P. 30)
Manually Setting the Options of the Device(P. 33)

12

Installing the Driver

Pre-installation Check
This describes the items to be checked beforehand in order to install the driver correctly.
System Requirements(P. 14)
About the Readme File(P. 15)
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System Requirements
Use one of the following system environments with this driver.

Operating Systems
Mac OS X 10.7.5 or later

Hardware
A computer guaranteed to operate using the above operating system.
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About the Readme File
The following content is contained in the Readme file.
● Limitations, restrictions, and cautions when installing or using the driver
● Devices that support the driver
Refer to README-ENG.html in the accompanying CD-ROM or the downloaded driver folder.
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Installing the Driver
This section explains the procedure for installing the driver to the operating system.
Install the driver and register the fax to use.

Prerequisites
Confirm that the following conditions are satisfied. Complete the preparation operations.
● Obtain the driver installer.
● System Requirements(P. 14)
● Close all running applications.
● If the computer and device are connected by USB, turn off the main power of the device.

Procedures

1
2

Open the driver installer folder → select [Canon_FAX_Installer.pkg] or
[Canon_Driver.pkg].
Read the Software License Agreement → click [Continue].
If a dialog box asking you to confirm that you agree to the Software License Agreement is displayed, click
[Agree].

3

Click [Install].
If a dialog box for entering a user name and/or password is displayed, enter the name and password of a
computer administrator and continue according to the instructions in the dialog box.
If a caution message regarding loading of the software is displayed, agree with the message to complete the
installation.

4

Click [Close].
Register the fax.

Related Topics
Flow of Preparations for Faxing(P. 12)
Registering a Fax Connected by TCP/IP(P. 18)
Registering a Fax Connected by USB(P. 22)
Registering a Fax Connected by Bonjour(P. 26)
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Registering a Fax
Register the fax you are going to use.
Select a registration method according to the method by which the computer and fax are connected.
Registering a Fax Connected by TCP/IP(P. 18)
Registering a Fax Connected by USB(P. 22)
Registering a Fax Connected by Bonjour(P. 26)
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Registering a Fax Connected by TCP/IP
You can register a fax connected by LPD (Line Printer Daemon) in the operating system.

Prerequisites
Confirm that the following conditions are satisfied. Complete the preparation operations.
● System Requirements(P. 14)
● Installing the Driver(P. 16)
● Confirmation of driver names corresponding to the fax
For fax names corresponding to printers, refer to the Readme file.
● Confirmation of specified IP address
If you do not know the IP address, check with the network administrator.
NOTE
● If IPP (Internet Printing Protocol) is usable, only IPv4 is supported.

Procedures

1
2

Display the [System Preferences] dialog box of the operating system → click [Printers &
Scanners].
Click [+] at the bottom of the displayed dialog box.
If a pull-down menu is displayed after you click [+], select [Add Printer or Scanner].
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3

Select [IP] in the toolbar → select [Line Printer Daemon – LPD] from [Protocol].

4

Enter the IP address of the fax in [Address] → select [Select Software] from [Use].
If the driver corresponding to the fax is displayed in [Use], proceed to step 6.(P. 20) .
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NOTE
● A message indicating that the IP address is incorrect may be displayed even if the correct IP address has
been entered.

5

Select the driver corresponding to the printer from the list in the [Printer Software]
dialog box → click [OK].

6

Change [Name] for the fax as necessary → click [Add].

7

Check that the registered fax and model are displayed in the dialog box.
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Set the device options as necessary.

Related Topics
Flow of Preparations for Faxing(P. 12)
About the Readme File(P. 15)
Enabling Automatic Setting of the Options of the Device(P. 30)
Manually Setting the Options of the Device(P. 33)
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Registering a Fax Connected by USB
You can register a fax connected by USB in the operating system.

Prerequisites
Confirm that the following conditions are satisfied. Complete the preparation operations.
● System Requirements(P. 14)
● Installing the Driver(P. 16)
● Confirmation of driver names corresponding to the fax
For fax names corresponding to printers, refer to the Readme file.
● Installation of the optional USB interface board (if required with the fax you are using)

Procedures

1

Display the [System Preferences] dialog box of the operating system → click [Printers &
Scanners].

2

Turn the fax on → connect the fax and the computer by USB cable.

3

Check that the connected fax and model are displayed in the dialog box.
When using a device via a USB connection in macOS 10.12.4 or later, the operating system may block loading
of the driver and prevent fax transmission, depending on the model of the device. If so, click the subsequent
"Open details."
1. Display the [System Preferences] dialog of the operating system → click [Security & Privacy].
2. Click [Allow] displayed on the [General] panel.
If the connected printer and model are not displayed, perform the following procedure.

4

Click [+] at the bottom of the displayed dialog box.
If a pull-down menu is displayed after you click [+], select [Add Printer or Scanner].
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5

Select [Default] in the toolbar → select a fax from the list.
Select a fax displayed as "USB" in [Kind].

6

Select [Select Software] from [Use].
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7

Select the driver corresponding to the printer from the list in the [Printer Software]
dialog box → click [OK].

8

Change [Name] for the fax as necessary → click [Add].

9

Check that the registered fax and model are displayed in the dialog box.
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Set the device options as necessary.

Related Topics
Flow of Preparations for Faxing(P. 12)
About the Readme File(P. 15)
Enabling Automatic Setting of the Options of the Device(P. 30)
Manually Setting the Options of the Device(P. 33)
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Registering a Fax Connected by Bonjour
You can register a fax connected by Bonjour to the operating system.

Prerequisites
Confirm that the following conditions are satisfied. Complete the preparation operations.
● System Requirements(P. 14)
● Installing the Driver(P. 16)
● Confirmation of driver names corresponding to the fax
For fax names corresponding to printers, refer to the Readme file.

Procedures

1
2

Display the [System Preferences] dialog box of the operating system → click [Printers &
Scanners].
Click [+] at the bottom of the displayed dialog box.
If a pull-down menu is displayed after you click [+], select [Add Printer or Scanner].

3

Select [Default] in the toolbar → select a fax from the list.
Select a fax displayed as "Bonjour" in [Kind].
If the corresponding driver is already registered in [Use] in the displayed dialog box, proceed to step 7.
(P. 28) .
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4

Select [Select Software] from [Use].
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5

Select the driver corresponding to the printer from the list in the [Printer Software]
dialog box → click [OK].

6

Change [Name] for the fax as necessary → click [Add].

7

Check that the registered fax and model are displayed in the dialog box.

Set the device options as necessary.
NOTE
● Fax transmission may fail when using a fax registered with a Bonjour connection. In this case, transmission
may be possible by registering the fax again with a TCP/IP connection.

Related Topics
Flow of Preparations for Faxing(P. 12)
About the Readme File(P. 15)
Registering a Fax Connected by TCP/IP(P. 18)
Enabling Automatic Setting of the Options of the Device(P. 30)
Manually Setting the Options of the Device(P. 33)
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Setting the Options of the Device
You can register, in the driver, the options (such as paper drawers and finishers) installed in the device, and set
the functions related to the options so that they can be used by the driver.
When using the device for the first time or adding options to the device, the option information must be
registered in the driver.
Enabling Automatic Setting of the Options of the Device(P. 30)
Manually Setting the Options of the Device(P. 33)
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Enabling Automatic Setting of the Options of the
Device
When using a device that supports bi-directional communication, you can set the computer to automatically
retrieve the option information of the device using the FAX Utility.

Prerequisites
Confirm that the following conditions are satisfied. Complete the preparation operations.
● Installing the Driver(P. 16)
● Registering a Fax(P. 17)
● Confirmation that the device you are using is set to perform duplex communication
For information on the setting method, refer to the manual of the device.
● Confirmation of driver names corresponding to the device
For driver names corresponding to devices, refer to the Readme file.

Procedures

1

Display the [System Preferences] dialog box of the operating system → click [Printers &
Scanners].

2

Select the device → click [Options & Supplies].

3

Select [Utility] → click [Open Printer Utility].
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4

Click [Printer Information] in the FAX Utility.

5

In the [Printer Information] dialog box, check the device information → click [OK].
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NOTE
● If the driver name displayed at the top of the [Printer Information] dialog box and the name displayed in
[Configuration] > [Name Retrieved from Printer] do not match, you may not be able to use the functions of
the device. If this happens, delete the device from the [System Preferences] of the operating system and
register the device again.

Related Topics
Flow of Preparations for Faxing(P. 12)
About the Readme File(P. 15)
Registering a Fax Connected by TCP/IP(P. 18)
Registering a Fax Connected by USB(P. 22)
Registering a Fax Connected by Bonjour(P. 26)
Manually Setting the Options of the Device(P. 33)
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Manually Setting the Options of the Device
If the device is connected by uni-directional communication, the options of the device must be set manually.

Prerequisites
Confirm that the following conditions are satisfied. Complete the preparation operations.
● Installing the Driver(P. 16)
● Registering a Fax(P. 17)
● Confirmation of driver names corresponding to the device
For driver names corresponding to devices, refer to the Readme file.

Procedures

1

Display the [System Preferences] dialog box of the operating system → click [Printers &
Scanners].

2

Select the device → click [Options & Supplies].

3

Click [Options].

4

In the displayed dialog box, check the options of the device → click [OK].
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NOTE
● Select only the options that are actually installed in the device.
● For information on operating the device, check the manual of the device.

Related Topics
Flow of Preparations for Faxing(P. 12)
About the Readme File(P. 15)
Registering a Fax Connected by TCP/IP(P. 18)
Registering a Fax Connected by USB(P. 22)
Registering a Fax Connected by Bonjour(P. 26)
Enabling Automatic Setting of the Options of the Device(P. 30)
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Uninstalling a Driver
This explains the procedure for uninstalling a driver that is no longer needed.

Prerequisites
Confirm that the following conditions are satisfied. Complete the preparation operations.
● When connected by USB, removal of the USB cable connecting the device and the computer
● Confirmation of the device name to be deleted
NOTE
● The driver can be upgraded. It is not necessary to uninstall the old driver.

Procedures

1
2

3

Display the [System Preferences] dialog box of the operating system → click [Printers &
Scanners].
Select the device to be uninstalled → click [-] displayed at the bottom of the dialog box.

Delete the files of the driver to be uninstalled in the following folders of the operating
system.
Library/Printers/Canon/CUPSFAX
Library/Printers/PPDs/Contents/Resources/CNMC****F.ppd.gz
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The name represented by "****" varies according to the device.
If a confirmation dialog box is displayed, enter an administrator name and password and click [OK].

4

Restart the operating system.
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Sending Faxes
Sending Faxes ..................................................................................................................................................... 38
Sending a Fax from an Application ..................................................................................................................... 39
Editing the Address Book .................................................................................................................................... 41
Attaching a Cover Sheet ...................................................................................................................................... 43
Arranging Multiple Pages on One Sheet of Paper ............................................................................................. 44
Registering Presets ............................................................................................................................................. 45
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Sending Faxes
Sending a Fax from an Application(P. 39)
Editing the Address Book(P. 41)
Attaching a Cover Sheet(P. 43)
Arranging Multiple Pages on One Sheet of Paper(P. 44)
Registering Presets(P. 45)
Setting the Authentication Function(P. 46)
Setting User Information(P. 47)
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Sending a Fax from an Application
This section explains the basic procedure for displaying the settings screen of the driver and sending a fax from
an application.

1

Select [Print] from the application's [File] menu.

2

Select the device from [Printer].

3

Select the [General Settings] panel from the pop-up menu of the print dialog box.
If no print options are displayed, click [Show Details] at the bottom of the screen.

4

Specify a destination.
When entering a new destination
Click [Add Destination] → enter [Fax Number] → click [Add] or [Add Destination].
When selecting from the address book
Click [Address Book] → select a destination → click Add or [Add Groups].
When adding a group as a destination, the numbers set as the highest priorities are displayed in [Edit] > [Edit
Distribution List] in [Contacts] or [Address Book] in the operating system.

5
6

Select the fax option from the pop-up menu of the print dialog box → set the required
items.
Click [Print].
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Related Topics
Flow of Preparations for Faxing(P. 12)
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Editing the Address Book
Fax Utility can be used to edit, import, and export the addresses registered in [Contacts] or [Address Book] in
the operating system.

To add or edit an address book card
You can add an address card to the address book or edit a registered card.

1

Open [System Preferences] in the operating system → click [Printers & Scanners].

2

Select the device you are using → click [Options & Supplies].

3

Select [Utility] → click [Open Printer Utility].

4

Click [Address Book].

5

Click [Add Card].
When editing a registered card, select the card → click [Edit Card].

6

Edit the items as required.

7

Click [OK].

To export an address book
You can export the contents of an address book using the FAX Utility.
You can import and use the saved file on another computer with a Windows version fax driver or device.

1

Select [Address Book] > [Export] from the [File] menu of the FAX Utility.

2

Specify the location to save to, the file name, and format.
When saving with the "*.csv" extension, select [CSV].
When saving with the "*.abk (Canon Address Book)" extension, select [LDIF].

3

Click [Save].
If there is group information, a "group information file (*.gsv)" is also saved with the same name as the saved
file name.
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If home and work destinations are both registered, the different destinations are saved in an extended LDIF
file.

To import an address book
You can use FAX Utility to import data to be used in an address book.
You can import the address book data on another computer, a Windows version fax driver, or device.

1

Select [Address Book] > [Import] > [File] or [Address Book of Fax Driver v3.70 or Earlier]
from the [File] menu of the FAX Utility.
If a dialog box indicating that "The address book will be registered" is displayed, click [OK].

2

Select a file to be imported (with the extension "*.csv (comma separated)", "*.dcm", or
"*.abk").
NOTE
● For group information files, if CSV files are present, they will be imported at the same time. Use file names so
that those parts without the extension (*.csv) match the CSV file. Also, when importing, place them in the
same folder as the CSV file.

3

Select [Use primary number as home fax number] or [Use primary number as work fax
number] → click [Open].
When importing as a group, enable [Import the selected file as a group] and enter [Group Name].

Device Address Books
The data of the address book registered on a device can be imported and used in the fax driver. An address
book edited in a computer can also be imported to a device.
For details, refer to the manual of the device.
NOTE
● When importing an address book exported with FAX Utility to a device, select the device to import to when
exporting the address book. Address book data exported for another device may not be able to be imported
correctly.

Related Topics
Setting User Information(P. 47)
FAX Utility Settings(P. 55)
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Attaching a Cover Sheet
You can attach a prepared cover sheet in the driver to the document to be sent.

1

Select [Cover Sheet] from the pop-up menu of the print dialog box.

2

Select the attachment method from [Cover Sheet Attachment].

3

Select a template from [Style].

4

If necessary, click [Item Settings] and configure the settings → click [OK].

Related Topics
[Cover Sheet] Panel(P. 54)

43

Sending Faxes

Arranging Multiple Pages on One Sheet of Paper
This section explains the procedure for printing multiple pages on a single sheet of paper.
Select the direction you want to arrange the pages in on the paper and print borders around the arranged
pages.

1
2

Select [Layout] from the pop-up menu.

Select the number of pages to be arranged on each sheet of paper from [Pages per
Sheet].
For detailed settings such as the direction in which the pages are arranged, printing borders around each
page, etc., perform the following procedure.

3

Select what direction the pages are to be arranged in from [Layout Direction].

4

Select the type of border from [Border].

5

Select the binding location when performing two-sided printing from [Two-Sided].
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Registering Presets
You can register frequently used print settings in [Presets] and recall the settings when printing.

1

Select a panel in the pop-up menu and set the functions to register as a preset.

2

Select [Save Current Settings as Preset] from [Presets].

3

Enter [Preset Name] → select [Preset Available For] → click [OK].
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Setting the Authentication Function
You can perform print management by means of the department ID management function or the user
authentication function.

Department ID Management
You can perform print management for groups using department IDs and PINs.

1
2

Select [Special Features] or [Advanced Settings] > [Authentication] from the pop-up
menu.
Enable Department ID Management → enter [Department ID] and [PIN].
If [User Management] is displayed, display the pop-up menu and select [Department ID Management].
If [Settings] is displayed, click [Settings] → set [Department ID] and [PIN] → click [OK].

User Authentication Management
You can perform user authentication management using user names and passwords.

1

Select [Special Features] from the pop-up menu.

2

Select [User Authentication] from [User Management] → click [Settings].

3

Enter [User Name] and [Password].

Related Topics
[Advanced Settings] Panel(P. 52)
[Special Features] Panel(P. 53)
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Setting User Information
You can set default settings relating to user information (PINs for department ID management and secured
printing, etc.) in the FAX Utility dialog box.

1

Display the [System Preferences] dialog box of the operating system → click [Printers &
Scanners].

2

Select the device → click [Options & Supplies].

3

Select the [Utility] tab → click [Open Printer Utility].

4

In the displayed FAX Utility dialog box, set the required items.

5

Click [Save Settings].

Related Topics
FAX Utility Settings(P. 55)
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Settings List
Settings List ......................................................................................................................................................... 49
[General Settings] Panel ...................................................................................................................................... 50
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[Cover Sheet] Panel ............................................................................................................................................. 54
FAX Utility Settings .............................................................................................................................................. 55
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Settings List
[General Settings] Panel(P. 50)
[Advanced Settings] Panel(P. 52)
[Special Features] Panel(P. 53)
[Cover Sheet] Panel(P. 54)
FAX Utility Settings(P. 55)
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[General Settings] Panel
You can set send destinations, send schedules, etc.

[Destination List]
Destinations specified for sending faxes are displayed in list form.

[Add Destination]
Adds a new destination.

[Destination Name]
Enter a destination name.

[Communication Mode]
Sets the mode to use for communication.

[Fax Number/URI]
Select whether to enter the fax number of the destination or enter a URI.

[Fax Number]/[URI]
Enter a fax number or URI according to the [Fax Number/URI] selection.

[Advanced Function]
Set this when using the subaddress function (function that adds a PIN) or the ISDN subaddress function
(function that adds a supplementary extension number).

[Address Book]
Selects a destination from the address book.

[Edit Destination]
Edits the destination selected in [Destination List].

[Delete]
Deletes the destination selected in [Destination List].

[Number of Destinations]
Displays the specified number of destinations.

[Set the Time to Send]
Specifies a send time. The send data is temporarily saved in the device, then sent at the specified time.

Related Topics
Sending a Fax from an Application(P. 39)
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Editing the Address Book(P. 41)
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[Advanced Settings] Panel
You can set the resolution, authentication function, etc. of the fax to be sent.

[Resolution]
Selects a resolution for the fax data to be sent.

[Line]
Specifies the phone line and outside line number for sending faxes.

[Specify Outside Dialing Prefix]
Use this when an outside line number is required.

[Select Line]
If there are multiple phone lines, select the line to be used for sending.

[Authentication]
Sets a department ID and PIN for managing fax transmissions.

[Use Department ID Management]
You can manage the fax transmission status for each registered department ID.

Related Topics
Sending a Fax from an Application(P. 39)
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[Special Features] Panel
You can set such management methods as sender settings and user authentication.

[Resolution]
Selects the resolution.

[Outside Dialing Prefix]/[Add Outside Dialing Prefix to G3/G4/IP Fax Number]
Use this when an outside line number is required. Enter an outline line number according to the communication
mode in [Settings].
Outside line numbers are not set for destinations that specify a URI.

[Select Line]
Selects the line to use. You can change the name of the line to a desired name in [Customize Line Name].

[Sender]
The specified sender name is displayed in the fax header. Changes this to a desired name in [Settings].

[Use Department ID Management]
Manages the fax transmission status for each registered department ID. Click [Settings] to set details.

[User Management]
Selects a management function to set. Set [Department ID Management] or [User Authentication].

[Reenter Fax Number Before Adding Destination to [Destination List]]/[Reenter Fax
Number/URI Before Adding Destination to [Destination List]]
Displays the [Confirm Destination] dialog box when adding a new destination in the [General Settings] panel. By
re-entering the fax number or URI, erroneous input is prevented.

Related Topics
Sending a Fax from an Application(P. 39)
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[Cover Sheet] Panel
You can set the content of the cover sheet attached to the fax transmission data.

[Cover Sheet Attachment]
Selects whether to attach a cover sheet.

[Different Sheet to Each Destination]
Attaches a cover sheet for each destination.

[Same Sheet to All Destinations]
Attaches the same cover sheet for all destinations.

[Item Settings]
Sets items to be displayed on the cover sheet.

[Labels and Comments]
Sets labels or comments for the included items.
[Insert Attention Note]
Attaches a label, such as "Urgent," "Confidential," etc. Select a label from the list in [Attention Note] or enter
desired text.
[Comment to Include]
Enter a comment if necessary.

[Sender]
Select the items to describe the sender and enter a description in each.

[Destination]
Specifies the items to be displayed on the cover sheet.

[Details]
Displays the number of pages being sent, the subject name, etc. in the cover sheet.

[Style]
Selects a cover sheet template.

Related Topics
Sending a Fax from an Application(P. 39)
Editing the Address Book(P. 41)
Attaching a Cover Sheet(P. 43)
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FAX Utility Settings
You can sets the initial values to use for the authentication function when sending faxes, etc. You can also add
or edit addresses in the address book.

[Printer Details] Panel
Sets the authentication function of the device. You can also check the information of the device you are using.
Common Items

This section describes the common items displayed in each dialog box.

[Printer Name]
Displays the name of the target printer.
If the utility was started from [Printers & Scanners], the printer name of the selected device is displayed.
If the utility was started from Finder, a list of the printer names of the devices registered in the operating
system is displayed.

[Kind]
Displays the type of driver that is set.
If the utility was started from [Printers & Scanners], the driver name of the selected device is displayed.
If the utility was started from Finder, a list of the driver names of the devices registered in the operating
system is displayed.

[Printer Information]
Displays the settings of the options installed in the device.
When duplex communication is used and device information can be retrieved, the option settings are
displayed.
When simplex communication is used or information cannot be retrieved from the device, the option settings
manually specified in advanced are displayed.

[Remote UI]
Displays the Remote UI page of the selected device.

[Save Settings]
Saves the changed settings.
[Department ID Management] Panel

Set this to perform Department ID Management.
Enter the numbers set on the device in [Department ID] and [PIN]. If you select [Verify], you can check whether
the values you entered match the device settings.
[Authentication Function] Panel

Set this when using [Department ID Management] or [User Authentication].
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Enter the values set on the device in [Department ID] and [PIN] or [User Name] and [Password]. If you select
[Verify], you can check whether the values you entered match the device settings.
[User Information] Panel

Sets the user name to use when sending faxes. If you selected [Enter Name], enter an arbitrary name. The user
name you set is displayed on the control panel of the device and used when sending faxes.
[Display Settings] Panel

Displays a confirmation message when sending faxes.

[Address Book] Panel
Updates the address book of the operating system.

[Add Card]
Adds a new address.

[Edit Card]
Changes the address that is registered.

Related Topics
Enabling Automatic Setting of the Options of the Device(P. 30)
Manually Setting the Options of the Device(P. 33)
Editing the Address Book(P. 41)
Setting the Authentication Function(P. 46)
Setting User Information(P. 47)
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Troubleshooting
Troubleshooting ............................................................................................................................................... 58
Cannot Register a Device Connected by Bonjour .............................................................................................. 59
Data Transmission to the Device Takes Too Long ............................................................................................. 60
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Troubleshooting
This explains solutions to common problems.
Limitations and precautions are also included in the Readme file.
Cannot Register a Device Connected by Bonjour(P. 59)
Data Transmission to the Device Takes Too Long(P. 60)
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Cannot Register a Device Connected by Bonjour
When registering a device connected by Bonjour in the operating system, the corresponding device may not be
displayed in the [Add] dialog box.
If this happens, it could be due to a number of causes. Change settings as necessary by referring to each
"Remedy."

Cause 1.
The settings of the device are incorrect

Remedy
Confirm that the Bonjour settings in the control panel of the device are enabled. For details, refer to the
manual of the device.

Cause 2.
The network settings of the operating system are incorrect

Remedy
Check whether the necessary settings have been configured in the network settings of the operating system.
If they have not been set, change the settings according to the following procedure.
(1) Display the [System Preferences] dialog box of the operating system → click [Network].
(2) Enable the network settings you are using in the [Network] panel.
(3) Click the [Finder] icon → click [Finder] > [Preferences] in the menu bar.
(4) Click the [General] tab in the [Finder Preferences] dialog box → enable [Connected servers].

Cause 3.
The driver has not been installed correctly

Remedy
Reinstall the driver and register the device again.

Related Topics
Installing the Driver(P. 16)
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Data Transmission to the Device Takes Too Long
If transmission takes a long time when sending data to the device, it could be caused by the following. Follow
the instructions described in "Remedy."

Cause
The amount of data being sent to the device is large, such as a document containing color photographs
or large images

Remedy
If the resolution of the image is higher than needed, set [Resolution] to an appropriate value in the [Advanced
Settings] or [Special Features] panel.

Related Topics
[Advanced Settings] Panel(P. 52)
[Special Features] Panel(P. 53)
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----------------------------------------------------------SIL OPEN FONT LICENSE Version 1.1 - 26 February 2007
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The goals of the Open Font License (OFL) are to stimulate worldwide
development of collaborative font projects, to support the font
creation efforts of academic and linguistic communities, and to
provide a free and open framework in which fonts may be shared and
improved in partnership with others.
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